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About this Adobe™ Acrobat™ Document
• Go through the Sample files example in minutes—and you’re on your way!

• The Table of Contents is interactive. Clicking on a topic in the TOC will take you to that section.

TIP: To interact with the Table of Contents, view this PDF file in bookmark view
(see circle on screen below), click on TOC and go directly to the Table of Contents.

• The Index is interactive. Just click on any index word and it will take you to the first
occurrence of that word.

TIP: Click on the Index from the bookmark (TOC) for quick access, then click on the Index word.

About the Toy Helicopter Sample Files included on the CD ROM
Images inside the sample file “Toy Copter” were captured using a standard 8mm video camera
running on a Power PC Macintosh, using an Xclaim™ video capture board (under $300, www.ati.com).
Using a video camera for object movie capture is quick and easy. It took a total of 90 seconds to
capture 36 images using the video camera. We also used the Magellan 1500 Object Rig, from
Kaidan, Inc. (www.kaidan.com) to capture multiband movies from a mechanism (object rig).

The other Object Movie “Sample Object Movie” was created from the PICT’s within the
Sample Files Folder. Use these files to create your own practive object movie.

Please  Read

Please Read
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• Widgetizer requires at least 8Mb of RAM allocated to itself. More RAM may become necessary when
working with extremely large file sizes.

• For QTVR playback outside of Widgetizer, you will need either MoviePlayer or QTVR Player.
Both are included on the Widgetizer CD-ROM. These are small applications designed to let you
quickly play your QTVR object movies. After the QTVR 2.0 extension is installed, you will find that
any application that supports QuickTime (such as SimpleText) will now be able to play QTVR movies.
After installing the above extensions by copying them to the System Folder, be sure to restart
your computer.

• Widgetizer is designed to do its best image work in 24 bit color depth (16.7 million colors,
monitor set to millions in the Monitors Control Panel). Widgetizer will also work in thousands
or 256 color levels.

Getting Widgetizer 1.0 ready to run

Are you using a Macintosh
PowerPC, Mac-compatible or 68KMac?

Are the extensions QuickTime 2.1,
QuickTime™ VR 2.0 in the System

Extensions folder?

Copy the QuickTime Extensions
folder from the Widgetizer CD-ROM
to your unopened System folder.
Important: Widgetizer CANNOT run
with QuickTime™ VR 1.0.

Do you have at least 8 megs of
real RAM allocated to Widgetizer?

Assign more memory to
Widgetizer via the File>Get Info
dialog box.

Widgetizer is now ready to run.

NO

Getting Ready to Run

YES

YES

YES

NO

You CANNOT use Widgetizer.
NO
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Widgetizer™ allows the creation of “object movies” saved into Apple™ QTVR file format, which are
playable cross platform. What is an object movie? Visualize placing an item (coffee cup) on a turntable.
Rotate the turntable at eye level to view the object at every 10 degrees for 360 degrees around the
object’s equator. This is movement called the “horizontal or column” setting.

Widgetizer allows further vertical capture called “bands.” Bands are usually captured in 10
degree increments and allow the images to be viewed above and below the objects equator—
allowing a 360 degree view of the object.

Remember images are composed onto a cylinder using an algorithmic function to gain the sense
of spatial dimension (that virtual sense). You’re either standing outside the cylinder watching one
frame move past (object movie view) or you are standing inside the cylinder watching a frame move
past (panoramic view).

QTVR is visually stimulating and detailed. Viewing is truly just like being there. Web catalogs,
museum holdings and CD or Web training are examples of early adopter QTVR commercial uses.

Widgetizer composes images taken with capture devices, usually a digital camera or video
camera shooting an object on a lighted turntable. The software assembles images into frames
then composes them into a single QTVR viewing window.  Now, just export the finished piece as
QTVR file format ready for playback by Apple QuickTime Movie Player or QTVR Player on Macintosh
or Windows.
IMPORTANT: When exporting the file, be sure to click the export option for Playback on Non-Mac OS
to flatten the file for Windows machines.

Overview of Widgetizer & Object Movies

Overview of Widgetizer

& QTVR Object Movies
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Setting Preferences

Application Startup Prefs
• Edit>Preferences>App. Startup
• Configure what will appear upon program startup.

Scratch Disk Prefs—Performance Tips
• Edit>Preferences>Scratch Disks
• Widgetizer Does NOT support Application Virtual Memory.
• Widgetizer DOES use a Scratch Disk (the system disk as default) as a swap disk to

automatically save images during node processing. The scratch disk temporarily stores the
work as it is processed. Once the SAVE button is pressed, those changes are updated to the
stored node file on the hard drive.

• TIP: The Scratch Disk feature also enables a recovery file (found in the Trash) should the program
or system crash. Drag the file from the Trash to the hard drive, then open it from Widgetizer.

• The auto save function processes according to the speed of the scratch disk. A faster drive, therefore,
speeds up processing between saves.

• Adequate disk space must be available for Widgetizer to use the Scratch Disk.
• We recommend allocating as much real RAM as possible, not relying only on Scratch Disk memory.
• Restart the program after switching Scratch Disks.

Setting Preferences—IMPORTANT!



 Page 7

File Storage Prefs
• Edit>Preferences>File Storage.
• File Storage preferences control performance during processing, NOT the quality of image.
• The Compressed (Lossless) selection does compress the file to decrease the node file’s size.

Raw does NOT compress the file, but processes faster. There is NO loss of data using Raw storage.

Author Info Prefs
• Edit>Preferences>Author Info> Field Pop-up menu.
• There are (3) fields for author info: Name, Copyright and Description. Any type of

information may be assigned to the fields.

• Author Info>Name>typically assigns the name of the object movie.
• Author Info>Copyright>allows you to create copyright messages. You may type out

“Copyright 1997, ABC, Inc.” or use the copyright symbol or create a custom warning
message. This is open for your discretion.

• Author Info>Description>typically assigns a factual description of what you are viewing
and further information such as Web site, etc.

Setting Preferences
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Author Info Prefs
• Author information shows up in some applications which enables movie information to

be displayed; such as Apple Movie Player 2.0, which uses the command “Show Copyright”.

QTVR Export Prefs
• Edit>Preferences>QTVR Export.

• QTVR Export enables a QTVR creator type to be assigned. This designates which application
the file will automatically open in, when double clicked. For example, most all users will have
Apple Movie Player installed, although maybe not QTVR 2.0 Player.

TIP: at this time, Movie Player has a more robust playback environment for QTVR,
than the QTVR player.

Setting Preferences
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After launching Widgetizer, notice that the Input Panel is the only accessible panel.
Other panels will highlight as essential object movie information is established panel by panel.

Image Size
Notice that image size width is always the longer dimension. Use custom sizes to create any
size than is not shown. Larger images sizes produce larger file sizes.

IMPORTANT: Widgetizer automatically resizes imported image dimensions to match the menu
Image Size specifications. In other words, Widgetizer will resample the images to your new
dimensions if they don’t match.

IMPORTANT: Concerning image size, resolution and resizing. When resizing object movies larger
than the original dimensions set in Image Size under the Input Panel—pixelization will occur when
resizing from low resolution to a higher resolution! For example: 320 x 240 was used as image size
in the Input Panel. A new dimension of 640 x 480 is desired for a larger screen presentation. The effect
of the new object movie resolution is to double the pixels needed, only 320 x 240 exist. To compensate
for the additional 320 x 240 needed, the pixels get larger, therefore appearing to be grainy or pixelated.

TIP: If you anticipate the need for larger object movie dimensions; it is best to start with a larger Image
Size in the beginning, then resize the down in the Compose Panel later.

Note: Video camera capture resolution is limited to 72 pixels per inch (ppi) at 640 x 480 ppi.
Smaller dimensions can be captured at 72 ppi.

Step One The INPUT Panel
First Step - Input Panel
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Acquire From—Establish the camera type, file or scanner used for source images

• Digital Cameras—most Acquire Plug-ins can be copied into Widgetizer’s plug-ins folder,
they then appear under Acquire From (example: Polaroid™ PDC-2000 & Apple QuickTake 200) .

• Setup—Click Setup for capture device and file options.

• PICT Files are imported for creating objects movies or reimported from touchup in Photoshop.
• PICT Files Setup—Click Setup for device and file options.

• TIP: Use Sequential numbering for importing single row object file names: 01name, 02name, etc.
• TIP: Use Sequential numbering for multiband object file names: 01,01name, 01,02name, etc.

Sequential numbering will allow All the images to be added in one selection, Add Total#.
Note: if you have hundreds of images (multiple bands) use 001name, 002name, etc.
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Acquire From—Establish the camera type, file or scanner used for source images

• Apple QuickTake 100, 150 & 200 digital cameras are used as capture devices.

• Apple QuickTake 100, 150 & 200 Setup...

Acquire From
• Apple QuickTake 200 comes with an Acquire Plug-in. Copy it to the Widgetizer’s Plug-ins folder,

then it will appear under Acquire From.

Note: More controls are
shown under Frames Panel.
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Acquire From
• Video Grabber allows video input signal into an MacAV or Mac with a video capture board.

Widgetizer grabs a single frame of video to be used as a source image without viewing
or allows interactive viewing.

• Video Grabber Setup...click Setup for capture device connection and despeckle option.
Despeckle automatically finds and takes out undesirable artifacts or speckles in the image.
This is good for lower quality video capture and object movies for the Web.

• Video Input Button will establish the video input connection (provided all your
extensions and control panel settings are installed and tested).

• Note: Further Video Grabber controls will be established in the next panel, Frames Panel.

Note: More Controls
are under Frames Panel.
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Mechanism (allows software to directly control an object rig)
Overview
The Magellan 15xx and Meridian C60 are object capture mechanisms from Kaidan. Both models have
Plug-ins, and ship with Widgetizer. Mechanisms are devices that use motor drives to rotate a turntable
and camera—around, above and below an object by degrees. This allows angular capture of the object
using the turntable. These mechanism actions are controlled by Widgetizer to allow automatic capture
of images, usually in 10 degree increments both horizontally (columns) and vertically (bands).
Note: Widgetizer supports Communication Tool Box. Therefore, Plug-ins will recognize any additional
serial ports installed in the computer (example: interface cards and splitters).

Object Movie Capture Positions (also see Vertical & Horizontal Settings, next)
Capture Around the Object’s Center
• Objects are usually captured in one 360 degree sweep around an object’s equator. This is also referred

to as one column horizontally, starting (centered) at 0 degrees by default (initial centered setting
may start anywhere).

Capture Above and Below the Object’s Center
• Objects may be captured in vertical sweeps called bands. Full vertical coverage is usually

considered 90 degrees starting (centered) at 0 degrees from a center of the object by default
(initial setting may start anywhere).

Capture Around the Object’s Center Multiple Times—while turning/adjusting the object each time.
(Example: animate a CD ROM case in several positions around the equator to show it opening)
• Objects are usually captured in one 360 degree sweep around an object’s equator. Here, multiple

captures around the equator are needed, because the object position and composition change.

Setting Up the Mechanism—Steps

• Choose the Image Size.
• Choose the Acquire From (video cameras with a MacAV work very well).

• Choose the Mechanism Plug-in, then click the Mechanism Setup Button (see Setup details next page).

First Step - Input Panel

Note: In Frames Panel, under Rapid Shot the Delay Between
Bands may be set. This is important to leave ample time for
the mechanism to shop vibrating after moving to a new position.
The default setting works well.
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Mechanism Setup
• Click the Mechanism Setup Button

Note: Open sample file “Music Box Object” to see an example of Magellan capture (Sample Folder).

Mechanism Turntable—Controller
• Controller—chooses Turntable movement for horizontal X or vertical movement Y or Disabled off.

Since the Turntable normally moves horizontally, it is defaulted on X. It may be Disabled, when
capturing vertical bands only.

• Speed—determines how fast the mechanism will move the Turntable. The default settings have been
tested and provide a good working speed.
Note: If the speed is increased too much, the object may fall off the Turntable.

Mechanism Swing-Arm—Controller
• Controller—chooses Swing-Arm movement for horizontal X or vertical movement Y or Disabled off.

Since the Swing-Arm normally moves vertically, it is defaulted on Y. It may be Disabled, when
capturing horizontal columns only.

Mechanism Interface
• Interface—tells Widgetizer where the mechanism is connected to the Macintosh.

Make Default
• Make Default—Changes only occur to the current project. Click the Make Default button to

save any new settings as defaults for subsequent files.
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Vertical Settings (rows define top to bottom settings)
• Think of the Vertical Setting as the distance from top to bottom of an object (or a little beyond)

in degrees. Each elevation in degrees is called a “Band.”

Note: Most object movies are created without vertical bands. Most object movies consist of one
360 degree sweep around the equator of the object. However, when projects call for creating multiple
perspectives—object “Rigs” or “Mechanisms” are used to simplify and automate the capture process.

Rigs automate the process of shooting bands by elevating the camera by the selected number
of degrees set on bands (normally 10 degrees), also rotating the object on the turntable for
360 degrees at each band. For example: the setting below is (1) band, over a zero degree
sweep and a spacing between captures of 10 degrees.

Notice the circle Icon Colors (shades) graphically visualize the amount of sweep.

• Sweep establishes the number of degrees traveled vertically in the object movie. The default
starting point is 180 degrees. The starting degrees may be changed in the “Centered at” box.

• Bands are the number of rows (or elevations) used to create the object movie. The default
setting is one.

• Spacing is the distance between images in degrees. The default setting is 10 degrees.

First Step - Input Panel
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Horizontal Settings (columns define around the object settings)
• Think of the Horizontal Setting as the distance around the equator of the object in degrees.

One complete rotation around the object from the center (starting at 0 degrees) is 360 degrees.
Notice the circle Icon Colors (shades) graphically visualize the amount of sweep.

• Sweep establishes the number of degrees traveled around the object. The default Starting Point
of the sweep is 0 degrees. The starting degrees may be changed in the “Centered at” box.
Object movies are typically created for 360 degrees. However, Widgetizer allows any custom
settings in the ”Centered at” box.

• Views are the number of images per column used to create the object movie. Since 360 degrees
is usually needed at 10 degree intervals, 36 views (images) will be needed.

• Frames Layers allow “Animation Layers” to be added to the object movie to create animation
within the object movie (example: flashing lights on the Toy helicopter). Add one layer for each frame
of animation intended (or one layer for each animated object). There may be as many layers
as the number of Views. Frame Layers will cycle through at that frame to create animation. Access
the layers in the lower left hand corner of the View Array in the Frames Panel. Playback the
animation after composing in the Playback Panel.
IMPORTANT—Frame Layers
a. There MUST be 2 or MORE Frame Layers to produce layers in the Frames Panel pop-up.
b. See further explanation of creating animation under the layers section, of Frames Panel.

• Spacing is the distance between images in degrees, which is normally 10 degrees.

• TIP: Spacing of 10 degrees is recommended for creating smooth object movies. File memory
can reduced by one half by increasing spacing to 20 degrees. Test the object movie in the
Playback Panel for quality levels.

• Go to the Frames Panel.

First Step - Input Panel
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• The Frames Panel captures or imports source images (frames) into the Capture Window and creates
numbered Thumbnail Views of each source image. The first number below the picon is the horizontal
(column) frame number (01, 01) and second number is the vertical (row) band number.

Image Numbers are determined in the Input Panel for frames and bands. Remember the type
of “Control Buttons” (PICT, digital camera, video grabber, etc.) shown on the Frames Panel are
determined by the “Acquire From” setting from Input.

Step Two The FRAMES Panel
Second Step - Frames Panel

Mechanism
• Mechanism appears—ONLY when selected from

the Input Panel. The Disclosure Triangle toggles
between a full panel frames display in View Array
and the Mechanism Camera Controller icon above.
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Acquire From
Control Buttons on the Frames Panel import images into Widgetizer.
The type of control button is determined by the  “Acquire From”
selected in Input Panel.

Acquire Buttons defined
PICT File – Single or Multiple Button imports one at a time or a series
of PICT images. Once images are shot or imported, the target frame will
automatically advance. Any frame may be manually highlighted by
clicking the frame, or use the Tab and Shift Tab convention.
TIP: Name your files 01name, 02name, etc., for consecutive loading.

Apple QuickTake 100 & 150 – Snapshot captures one shot per mouse
click. Interactive shoots the entire sequence, stores on camera, then
imports. Download brings images already shot and stored on the camera
into Widgetizer. Click on Erase to delete the images on the camera
storage drive.

IMPORTANT: A Word About Digital Cameras.
Almost all digital cameras can export their files as PICT images, so don’t
be alarmed if you see that there is no “import” option for your particu-
lar make of camera. If your camera is not one of the QuickTake family
from Apple or the PDC-2000 from Polaroid, you should use the PICT or
PhotoCD import options. The special options offered to these digital
cameras are due to the presence of “tethered control” plug-in modules
being present in the Plug-Ins folder in Widgetizer. More tethered-control
modules for other digital cameras will be available soon and posted to
our web site. Check - http://www.panimation.com for updates.

Second Step - Frames Panel

Mechanism
• Mechanism Target View—Can be viewed by Angle or Index (by number series).
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Video Grabber - Controller

Framing
• Framing presents a window, which allows the object to be aligned to the center of camera

capture frame. If not aligned the object will NOT appear to rotate around it’s center within
the object movie window during play back. It will appear to wobble from side to side.

TIP: When using a turntable, turn the image every 45 degrees, then open Framing.
Use Framing to check precise object alignment of the center—at these key angles.
Precise alignment at 45 degree angles will ensure a smooth appearance when the object
movie rotates.

TIP: Watch carefully which point will make the best center of the object. It is NOT always the dead
center of the object. For example: a Darth Vader™ figurine with a cape. It may work better to choose
the center to be little off to account for the wideness of the cape. Otherwise, when the object movie
is turned—it will cut off part of the image and look unnatural in the way it turns.

• The Arrows are ONLY enabled when a mechanism is chosen from Input Panels. Click the Arrows
top/bottom and left/right to move the camera to capture angles. Use the cross hairs feature to
align the image. Select Lock to capture and display on screen as the object is rotated. This allows
This allows the object to be viewed in two positons at once.

Second Step - Frames Panel
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Video Grabber - Controller

Framing

• Click the Input button to get the video controller dialogue box.
• Choose Image or Source from the Pop-up menu.
• Image is a standard digital video image adjustment controller.

Move sliders to evoke changes. Changes are viewed inside the right hand window.
• Source sets the digital video card to be used and the video format,

which is NTSC in North America.

Snapshot
• Snapshot captures one frame per mouse click. Snapshot assumes Framing has been done. The image

being captured is NOT visible using Snapshot. It automatically advances to next frame after capture.
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• Interactive allows you to shoot the entire sequence, then import your chosen frames.
Interactive mode provides a visual interface to see the object before capture.

• Rapid Shot is used with a mechanism for unattended acquisition.
It allows a specified number of frames for capture and time delay between shots.
Time delay between shots is important, it creates time for the sway created by
moving rig parts to halt before the next picture. Otherwise, the camera would
shoot while movement occurs.

• Once images have been acquired, Compose Panel is accessible.

Layers—Animation Layers pop-up
• Set number of Frame Layers needed from Input Panel.
• Go to Layer pop-up>Click on desired layer.
• Scroll frames>Go to any existing frame>Copy/Paste to desired layer.
• Edit Layer Frame(s) for desired animation .
• Example: Assign 3 layers>copy/paste one frame>color (edit) copter lights

in each Layer Frame>One red layer 2>One yellow layer 3.
• IMPORTANT: Must Compose movie to see animation>drag movie to angle edited in layers to see

animation>Edited frames will cycle at that angle only to create the animation (they are stacked
behind each frame>animation feature cycles frames to create animation).

• Go to the Compose Panel.
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Step Three The Hot Spot Panel
Third Step - Hot Spot Panel

CREATING AND DEFINING HOT SPOTS
Hot Spot Overview
The Hot Spot Tool Palette provides multiple shape tools to define any area as a Hot Spot. Hot Spots
are defined by each angle position (example: every 10 degrees rotation). Hot Spot tools are only available
while in the Hot Spot Panel and viewing that EXACT angle. Select a tool to define a Hot Spot area, this
automatically names and numbers the Hot Spot in the sequence window. Double click on Hot Spot for
Properties options.

IMPORTANT—Hot Spots ONLY apply to individual angles.
Note: Keep in mind that once the object movie view is moved by the user, the Hot Spot angle (position)
changes. Therefore, Hot Spots are needed at each rotation angle to provide interaction at the new view.
• One Hot Spot ONLY applies to ONE angle position.
• Unlimited Hot Spots can be applied to ONE angle.

    Exact Hot Spot Angle at 348.00 degrees (see icon).
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Creating Hot Spots—Steps
• Locate desired angle—Click the Arrows to move the object movie to desired angle.

• Select a Hot Spot tool shape.
• For Square, rectangle, circle, oval>click hold, drag to create the area dimension.
• For Polygon>click, release, click: get the number of desired points, then double click to close path.

• Naming & ID#—Consecutive Hot Spot names and ID numbers are automatically assigned
as Hot Spot 1, 2, etc.

• Rename—Double click on Hot Spot to get Properties dialogue box to rename.
• Renumber ID—Double click on Hot Spot in Properties dialogue box to renumber the ID.

• Color—Change the Hot Spot color by single clicking on the color chip to get the color picker
Note: There is no limit to the number of Hot Spots or colors assigned.

Copying Hot Spots to New Angles
• Use Arrows—Rotate to new angle.
• Copy/Paste—Hot Spots can be copied and pasted to any other angle, then change Properties.
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Hot Spot Properties—Double click on the Hot Spot (not the name)
• Double click on the Hot Spot area to get the Properties dialog box.

Kinds of Hot Spots
• Kinds of Hot Spots are defined by Apple QTVR programming guidelines and differ

in meaning for various playback environments.
• Use the default “Navigable Object,” unless the other playback environment is known.
• Other kinds of Hot Spots will behave according to specific playback environments.

Reference the documentation of the specific playback environment for playback behaviors.

ID
• ID—Is the unique number between 1-254 to identify that Hot Spot.

Note: In some playback environments it will necessary to reference the ID#, not the name.

Name
• Name—Assigns a Alpha/Numeric name to the Hot Spot.

Comments
• Comments—Arbitrary comments may be typed. For example info about intended links.
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IMPORTANT—Linking Hot Spots to other files, after they are created.
Widgetizer Does NOT link hot spots to other object or panoramic movies. It only creates Hot Spots.
In the near future, a new Panimation software called VR Tool Suite™ will combine the creation
features of both Nodester for panoramics and Widgetizer for object movies and allow hot spots to be
linked to other files. Currently, Hot Spots can be linked using various multimedia applications such
Macromedia’s™ Director™ or mFactory’s™ mTropolis™. Other multimedia assembly softwares are
revising code for new versions to include QTVR linking (Hyperstudio™ and others).

Visit the Web site (http://www.panimation.com) for tips and links regarding for linking Hot Spots
to other movie files.

Third Step - Hot Spot Panel



 Page 26

Compression
1. Click Set Button to choose the Codec (Compressor/Decompressor). These options are standard

Apple QuickTime compressors for compressing the QT and QTVR movies. Using different codecs
will affect the file size and quality of your QTVR movie. Cinepak™ is the default and works well
for most applications.

IMPORTANT: Cinepak is, until QuickTime 2.0 for Windows ships, the ONLY codec that
is certain to play back QTVR properly on Non-Mac OS computers. If you intend to develop QTVR
for cross-platform viewing (i.e. the Web or a hybrid CD-ROM), we recommend that you leave the
program defaults: Cinepak, Best Depth and High Quality.

    

Step Four The COMPOSE Panel
Fourth Step - Compose Panel
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Compression & Options
2. Choose a Compression Quality to compose the QTVR movie. Depending upon the

Codec chosen, you may not necessarily see a difference.

• For playback on computer screen we have found Cinepak, quality 75% works well.
• For playback on the Web we have found Photo - JPEG, quality setting of between 25%

to 50% works well.

• For playback of super High Quality on computer screen we have found Cinepak,
high quality works well (example: Xrays). However, the file size will be large.

3. Choose the Color Depth. Widgetizer is optimized for 24-bit color (16.7 million colors).

4. Frame Size allows the resizing of the object movies. Frame size is defaulted to the dimensions
assigned in the Input Panel. To be sure, Frame Size allows movies to be resized larger or smaller
to create various versions of the object movie.

IMPORTANT: Concerning Image Resolution. When resizing object movies larger than the
original dimensions set in Image Size under the Input Panel, pixelization will occur.
For example: 320 x 240 was used as image size in the Input Panel. A new dimension of 640 x 480
is desired for a larger screen presentation. The effect of the new object movie resolution is to
double the the pixels needed, only 320 x 240 exist. To compensate for the additional 320 x 240
needed, the pixels get larger, therefore appearing to be grainy or pixelated.

TIP: If you anticipate the need for larger object movie dimensions, it is best to start with a
larger Image Size in the beginning, then resize the down in the Compose Panel later.

Note: Video camera capture resolution is limited to 72 pixels per inch (ppi) at 640 x 480 ppi.
Smaller dimensions can be captured at 72 ppi.

Fourth Step - Compose Panel
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Effects—Background or Sound

Background (creates a new background with PICT file or Pattern)
• Choose Background.

• Choose Type as either a Picture (PICT) or Pattern (Built-in);
which is swapped with the current object movie background by use of the Mask (uses a key color).

Getting a True Solid Background
• A Pure Hue (High Chroma Green, Royal Blue) MUST be used as a background when shooting the

object movie. This allows the mask to be accurate when selecting and replacing the new background.

• Choose a Range setting between plus or minus 50 (start at default).
Range allows a “Controlled Range” of colors to be selected within the mask—this improves
the edge detail and appearance of the mask selection around the object.

• Move cursor over the Source window. See the Eye Dropper. Click with the Eye Dropper to establish
the Mask Color. When the movie is composed, the mask color chosen will be replaced with the
new background PICT.

• Click Options button. Choose Tile or Scale.

• Click Select button and import the new background PICT file or copy and paste.

IMPORTANT: The Background image will NOT appear masked until the object movie is composed.

Fourth Step - Compose Panel
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Effects

Pattern (creates new background with built-in patterns)
• Choose Background from the pop-up menu.

• Choose Pattern from the Type pop-up menu.

• Click the Select button, then Scroll patterns and choose one, click OK.

• Move the cursor over the source image. You see an eye dropper, click to choose
the mask color. When the movie is composed the mask color chosen will be
replaced with the new background PICT.

• Note: you will not see the switch until viewed in the playback window.

Fourth Step - Compose Panel
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Effects—Sound
Sound
• Effects allows Sounds to Added for the duration or the object movie (Global)

or “Hot Spotted” to a view location (Angle) within the object movie (Local).
• Choose Sound in the pop-up.

• Click the Add Button to import Sound file formats: AIFF, SND or QuickTime.
Note: QuickTime may include an embedded MIDI file.

• Add an Unlimited number of sound tracks.
• Click the Record Button to record directly using the Macintosh microphone.
• Test the sounds and use the Volume and Balance to edit.
• Global assigns the sound to the entire length or duration of the object movie.
• Local assigns the sound to specific frames.
• Click on Assign Button>Click arrows to move to each angle (highlights)>Click to Enable sound.

Compose Button
• Click on the Compose Button, after Compression and Effects

have been established.
• This will create a sample QTVR file in the Playback Panel

for viewing and further file setup options.
• Go to Frames Panel.

Fourth Step - Compose Panel
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Playback
View the sample object movie in the Playback Panel. To Play the QTVR object movie, move the
cursor over the Playback window. A hand icon will appear to steer left/right and top/bottom
(if there are bands or a small window). Click, hold and drag left or right when you see the icon.

Window Size
Window Size allows the object movie to be resized. Resize inside the playback panel window
by clicking and dragging the Resizing Handle in the lower right corner of the window.

TIP: Command drag to proportionally constrain the window. Specific dimensions may be keyed
into the width and height Window Size boxes.

IMPORTANT: Concerning Image Resolution. When resizing object movies larger than the original
dimensions set in Image Size under the Input Panel. pixelization will occur. For example: 320 x 240
was used as image size in the Input Panel. A new dimension of 640 x 480 is desired for a larger screen
presentation. The effect of the new object movie resolution is to double the pixels needed, only
320 x 240 exist. To compensate for the additional 320 x 240 needed, the pixels get larger, therefore
appearing to be grainy or pixelated.

TIP: If you anticipate the need for larger object movie dimensions; it is best to start with a
larger Image Size in the beginning, then resize the down in the Compose Panel later.

Note: Video camera capture resolution is limited to 72 pixels per inch (ppi) at 640 x 480 ppi.
Smaller dimensions can be captured at 72 ppi.

Step Five The PLAYBACK Panel
Fifth Step - Playback Panel
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Attributes

Author Button
Author button (allows copyright and document info to be attached to the file).
• Click on the Author Button.

• Author Information dialogue box comes up. Key in the desired information.

• TIP: Key the Author Info Preferences for any repetitive information, which will
automatically attach to each object movie file.

Fifth Step - Playback Panel
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Interaction Button

Interaction
• Click on the Interaction Button.

Controller
• Choose the Controller Method from the pop-up.
• Experiment with various methods. Joystick shows multidirectional icons.
• Motion Scale allows the object movie to move faster or slower when the mouse is moved.

Faster allows the movie to move quickly when the mouse is moved slightly. Depending on
the viewers needs, the object movie can spin slow or fast.

   

View Animation
• Wrap when Panning - allows movie Pan to continuously spin 360 degrees, otherwise it

stops after one full horizontal sweep is reached.
• Wrap when Tilting -  allows movie Tilt to continuously spin 360 degrees, otherwise it

stops after one full vertical sweep is reached.
• Allow Zooming - allows user to zoom in and out. If box is unchecked no zooming can occur.
• Allow Translation - allows the view of the object to be scrolled when zoomed in.
• Reverse Pan Direction - plays movie Pan in opposite direction of mouse action

(drag left, movie goes right).
• Reverse Tilt Direction - plays movie Tilt in opposite direction of mouse action

(drag up, movie goes down).
• Swap Pan & Tilt Control - Pans the movie left to right when the mouse it dragged

up and down and visa versa.

Fifth Step - Playback Panel



 Page 34Fifth Step - Playback Panel

Animation Button
Frame Animation
• Enabled - turns on Frame Animation.
• Restart for Each View - once moved and stopped the object movie returns to the

initial frame of the animation.
• Play Backwards - animation plays in the opposite direction.
• Loop when Finished - instructs the movie to repeat the animation when complete.
• Speed - sets the playback speed of the animation. Depending on the type of effect

needed for the viewer the animation can play slow or fast.

View Animation
• Enabled - turns on View Animation.
• Play Backwards - view animation plays in the opposite direction.
• Loop Back-and-Forth - reverses direction of the view animation when the

horizontal sweep limit is reached.
• Sync. to Frame Animation - allows the entire frame animation to play for

each view of the object.
• Speed - sets the playback speed of the animation. Depending on the type of

effect needed for the viewer the animation can play slow or fast.
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Playback Button

Video
• High Quality - introduces a dithering function to make the movie appear

sharper and crisper.

• Preload - allows loading to occur prior to opening. May cause a slight delay
in opening, however the movie will play smoother.

• Cache Data - tells the movie to retain as much calculated data as possible,
which causes the movie to play smoother. Cache Data increases RAM consumption
of application RAM to play the movie more efficiently. This a good for games,
interactive CD’s and interactive multimedia.

Sound
• Sound Interpolation - plays lower quality sound samples at a higher fidelity.

• Preload - allows loading to occur prior to opening. May cause a slight delay
in opening, however the movie will play smoother.

• Cache Data - Tells the movie to retain as much calculated data as possible,
which causes the movie to play smoother. Cache Data increases RAM consumption
of application RAM to play the movie more efficiently. This a good for games,
interactive CD’s and interactive multimedia.
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View Settings

Poster View
• Poster View - is the icon image you see when:

previewing a file in a open dialogue box, seeing a desktop file by icon view or when you get info.

• To Set the Poster View, drag the movie in the Playback Panel window to the frame (scene)
desired. Now, click the Set Button. If you have moved the movie from the Poster View and
wish to return to it, click the Go Button.

Initial View
• Initial View - is the first image seen when the file is opened, before it is played.

• To Set the Initial View, drag the movie in the Playback Panel window to the frame (scene)
desired. Now, click the Set Button. If you have moved the movie from the Initial View and
wish to return to it, click the Go Button.

View Angles
• View angles are located at the bottom of the Playback Panel. View angles display the positions

as the object movie is moved inside the view window.

• TIP: Notice the Approx. File Size reading. This tells you the approximate finished size of the
object movie, which is a helpful reference.
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1. Test the QTVR Object Movie in the Playback Panel window as needed, then Export>File
as QTVR Movie File Format (QTVR 1.0 or QTVR 2.0).

2. QTVR Object movies may be played back from an Apple Movie Player or inside a
QuickTime VR Player (provided the QTVR 2.0 System Extension is installed).

3. Check the Playable on Non-Mac OS computers setting: if you want this QTVR movie to
play on other Operating Systems that support QTVR playback. Checking this box
will flatten the movie.

IMPORTANT: Virtual Documentation on the Web site (http://www.panimation.com).
The interactive example and levels of supporting information will reside on the Panimation
Web site as a virtual updating document. As Widgetizer develops and users send in tips, tricks
and techniques, all of this will be placed on the Web site for public download.

IMPORTANT: Users Tips, Techniques & Features Web Site Bank. We encourage all of you to email us
on a regular basis with your findings and requests. We will compile tips and techniques for every aspect
of QTVR development (cameras, shooting, mounts, software, and software feature requests). This Web
Bank of entries will benefit all QTVR developers.

IMPORTANT: Send Samples of your QTVR Object and Panorama Movies to Panimation. Please send
your best object movies to Panimation. We are regularly updating our gallery of examples for
future ezine CD-ROMs and viewing on our Web site. We appreciate seeing what people are doing
with our software! We can accept object movies as compressed attachments or by mail on floppy discs.
Please include your email address. Tell us about your movies (where, what, when) and any interesting
aspects of your project.

Export File as a QTVR Object Movie

Sixth Step - Export File as QTVR
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Object Rigs

We at Panimation feel strongly that your best QTVR object movies are achieved using the
best equipment to record precisely aligned images. Widgetizer is one component of your
“toolbox”—a quality (QTVR-oriented) object rig or camera mount should be another.

PEACE RIVER STUDIOS
http://www.peaceriverstudios.com
9 Montague Street
Cambridge, MA 02139-3721
Voice 617.491.6262
Fax 617.491.6703

KAIDAN
http://www.kaidan.com
703 East Pennsylvania Blvd.
Feasterville Business Campus
Feasterville, PA 19053
Voice 215.364.1778
Fax 215.322.4186

EquipmentSixth Step - Export File as QTVR
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